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Regulation Compliance

FCC Information Test

FCC Warning: This equipment meets the limits for a Class B digital device, pursuant to Part 15 of
FCC Rules. Only the power pack and cable supplied with the camera should be used. Operation
with other power packs and cables is likely to result in interference to radio and TV reception and
could void the user’s authorization to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause
undesired operation.

Changes or modifications not expressly approved by the manufacturer may void the user’s authority
to operate this equipment.

The limits for a Class B digital device, pursuant to Part 15 of the FCC Rules, are designed to
provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by switching the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

! Reorient or relocate the receiving antenna.

! Increase the separation between the equipment and receiver.

! Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

 Canadian Radio Interference Regulations Statement

 This Class B digital device meets all the requirements of the Canadian Interference-Causing
Equipment Regulations.

 Cet appareil numérique de la Classe B respecte toutes les exigences du Réglement sur le matériel
brouilleur du Canada.
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 CE Declaration of conformity according to ISO/IES Guide
22 and EN 45014

 This equipment complies with the requirements of the Low Voltage Directive 73/23/ECC,
93/68/ECC standards: EN 60950: 1995/A3.

 This equipment complies with the requirements of the EMC Directive 89/336/ECC

 Standards: EN 50081-1-EN55022 class B

 EN 50082-1-EN61000-4-2, EN61000-4-3, EN610004-4
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Warranty
Agfa warrants this product to be free from defects of material and workmanship for one (1) year
from the date of purchase. During the warranty period, Agfa will repair or replace, at its option, the
product at no charge to the customer. The replacement unit may be a re-manufactured unit or a
unit of equal or greater functionality. After one (1) year, Customer shall pay for all parts, labor and
service.

Agfa warrants that software products will conform to published specifications in effect at the time of
delivery for 90 days after purchase. Customer acknowledges that the Software may have inherent
defects because of its complexity. The warranty applies only to the media on which the software is
recorded. During the 90 days period, Agfa guaranties limited free support. Support on third party
software (included with the ePhoto CL34) is limited to the direct interaction with the ePhoto CL34
camera, or with the Agfa-developed software.

If a unit is replaced during the warranty period, the original warranty shall remain in effect until the
end of the one (1) year period or shall be 30 days, whichever is longer.

This warranty is transferable with new owner notification to Agfa.

This warranty shall not apply if the customer:

! Abuses or modifies Product or Software.

! Operates the system in an environment with excessive dirt, moisture, chemical fumes,
extremes of temperature or other improper conditions. The camera is not impermeable to
water, dust or sand.

! Supplies other Software or Interfacing.

 Warranty service is excluded if the serial number of the product has been tampered with or
removed.

Caution: The parties agree that all other warranties, express or implied, including warranties of
fitness for a particular purpose, merchantability and non-infringement, are excluded.
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Safety Information
! To reduce the risk of electric shock, do not disassemble the camera.

! To reduce the risk of fire or electric shock, do not expose the camera to rain or moisture. Refer
all servicing to qualified service personnel.

! Only use the following batteries: AA Alkaline, AA Lithium or AA NiMH batteries. Do not use
batteries that show signs of leakage, corrosion or swelling, or that are excessively warm.
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Care and Maintenance
! Avoid leaving the camera in the sun or in a very warm location (beach, car, and so on) for

prolonged periods.

! Do not wrap the camera in cloth or plastic while it is on (heat and moisture may be trapped and
damage the camera).

! Avoid using the camera in excessively cold (below 0°C/32°F) or excessively warm (above
40°C/104°F) conditions.

! When you bring the camera from a cold to a warm location, allow the camera to reach room
temperature before you use it.

! If condensation develops inside the camera, stop using it immediately. Remove the batteries
and (if needed) the CompactFlash memory card and leave the camera at room temperature
for a few hours to allow the condensation to evaporate.

! To clean the camera lens or LCD, blow away any surface dust or dirt. Then breathe on the
surface to form a mist and gently wipe it with a soft, lint-free cloth or lens cleaning tissue.

! To avoid scratching the lens, use a gentle, circular motion when wiping.

! Never use harsh or abrasive cleaners on the outside surfaces of the camera. Wipe off dust
with a clean, dry cloth.
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Introduction
Your ePhoto CL34 records high photo-quality digital images. You just have to point and click to
record images. Using the Jog Dial wheel you can easily and quickly change the camera settings.

To read more on your Agfa product, visit: http://www.agfa.com

With the ePhoto CL34 you can:

! Check the camera settings on the status display.

! Frame images with the optical viewfinder or color LCD screen.

! Record images and videoclips and immediately review them on the color LCD screen.

! Store images in the camera’s 2MB internal memory or on an optional CompactFlash card.

! Immediately decide whether you want to keep or delete the image you recorded.

! Immediately load images into a computer, print them, use them on the Web, attach them to e-
mails, ...

! Immediately print images through the AGFAnet internet print service using the Print button.

! Transfer still images or videoclips to your PC, capture videoclips or attend a videoconference
using a USB connection.

! Capture videoclips up to 20 seconds on the internal memory (10fps) and up to 30 seconds on
an optional CompactFlash card (20fps).

! Capture 3 low resolution images/second in Burst mode (for maximum 3.5 seconds). This
requires an additional processing time of 7 seconds.

! Transfer your images to a computer using a fast USB connection (this requires a computer
and an operating system compatible with the USB interface).

! Tag your images to be printed on a minilab that supports DPOF™ (Digital Print Order Format)
or on a printer that supports DPOF.

http://www.agfa.com/
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Chapter 1: Getting to Know Your Camera

1 CompactFlash™ Slot

To insert an optional CompactFlash™ memory card.

2 Shutter Button

To record an image or a videoclip.

3 Built-in Flash

To light dark scenes.

4 Display

To see the settings on a black and white display.

5 Timer Indicator

A blinking red light indicates that the selftimer is activated.

6 Lens

f = 7.1 mm (50 mm equivalent).

7 Macro switch

To switch the focal range from normal mode (65 cm / 25.6” – infinity) to macro mode (25 cm /
9.8”).

8 Battery Compartment

To insert 4 AA Alkaline, AA Lithium or AA NiMH batteries.
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1 USB Port ( )
To connect your camera with a USB cable to your computer.

2 Print Button
To upload your images via the internet to the AGFAnet Printing Service.

3 Green Action Indicator
A steady green light indicates that the camera is ready. The green action indicator blinks when
the camera starts up, processes an image or when the flash is charging.

4 Viewfinder
To frame images or record videoclips.

5 Resolution Button
To set the resolution of your camera.

6 Selftimer Button
To activate the selftimer.

7 Flash Button
To set the desired flash setting.

8 PLAY/OFF/REC Auto Return Switch
To switch the camera on or off.

9 1.8” Color LCD screen
To frame images or record videoclips or to preview recorded images/videoclips.
To select options from the Record or Play menu (row of icons).

10 Jog Dial wheel
To scroll through the menu options (by pressing the arrow buttons) and select options (by
pressing the Enter button in the center of the Jog Dial wheel).

11 Tripod Mount
To mount the camera on a tripod or cradle.
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Power Sources

Your ePhoto CL34 has two possible power sources:

! batteries

! USB power

Batteries

Inserting batteries

Your ePhoto CL34 camera comes with 4 AA Alkaline batteries.

" Note: You can also use AA NiMH or AA Lithium batteries.

1 Open the door of the battery compartment.

2 Insert 4 AA appropriate batteries. Make sure the pole-marks on the batteries (+ and -)
correspond to those in the battery compartment.

3 Slide the battery compartment door back into place.

Battery status

The Display always indicates the status of the battery. Segments disappear as power is used.

Full Half-full Nearly Empty

" Note: The Nearly Empty-icon indicates that the inserted batteries will power your camera for
only a few minutes more.

Battery care

! If you are not going to use your camera for an extended period of time, remove the batteries to
prevent leaks or corrosion.

! Before replacing the batteries, switch OFF the camera.

! Use only size AA Alkaline, NiMH (with a minimum capacity of 1200 mAh) or Lithium batteries.

! Do not use batteries that show signs of leakage, corrosion or swelling.

! Do not use batteries that are excessively warm.

! If necessary, clean battery contacts with a dry cloth before installation.

! Always replace all batteries with four identical, new (or fully charged) ones.

! Dispose used batteries in a manner that complies with applicable laws.
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Tips for saving battery life
In order to extend battery life use following tips:

! Use the optical viewfinder instead of the LCD to frame images.

! When recording more than one image, do not switch on and off the camera too often. After 30
seconds of inactivity the LCD automatically switches off.

USB Power

The moment you connect your camera to a PC (with the supplied USB cable), it is powered by the
PC (and does not use battery power).

" Note: If the camera is USB-powered the flash is disabled.

Memory Options
You can store captured images or recorded videoclips in two ways:

! In the Internal memory (2 MB).

! On an optional CompactFlash memory card (external memory of 4, 8, 16, 32, 64, …MB
capacity).

Internal Memory

Your ePhoto CL34 camera comes with an internal memory of 2 MB where you can:

! store 4 images in Fine resolution (1280 x 960 pixels), 10 images in High resolution (1024 x 768
pixels) and up to 36 images in Low resolution (512 x 384 pixels);

! record 3 images/second for a maximum period of 3.5 seconds in Burst Mode;

! record a videoclip up to 20 seconds in Video Mode at 10 frames per second.

Inserting/Removing an Optional CompactFlash Memory Card

Using a CompactFlash™ memory card you can:

! store more images than on the internal memory of your camera;

! record 3 images/second for a maximum period of 3.5 seconds in Burst Mode;

! record a videoclip up to 30 seconds in Video mode at 20 frames per second.

Caution: Switch off your camera before inserting or removing a CompactFlash™ memory card.

1 Remove the CompactFlash™ card cover from the memory card slot.

" Note: When no CompactFlash™ card is inserted, the CompactFlash cover will keep your
ePhoto CL34 dustfree.

2 Connect the CompactFlash™ card cover to the CompactFlash card.
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3 Insert the CompactFlash™ card and push it all the way into the slot.

" Note: The memory card is shaped so that it can only be inserted into the slot in the correct
way. Do not force the card.

" Note: To remove a card, switch off the camera, pull the CompactFlash cover out of the
memory card slot and disconnect the CompactFlash card from the cover.

" Note: With a CompactFlash card inserted, the internal memory cannot be used.

Formatting an Optional CompactFlash Memory Card

When your CompactFlash card does not work properly or when you permanently want to remove all
data from your memory card, format your CompactFlash card. When your optional CompactFlash
card is working properly, you do not need to format it.

" Note: Make sure you inserted an optional CompactFlash memory card as described in
Inserting/Removing an Optional CompactFlash Memory Card.

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

3 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  icon.

4 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Delete Pictures window appears.

5 Scroll using the up/down arrow of the Jog Dial wheel to highlight the Reformat option.

6 Press the Enter button.

A confirmation screen appears.

7 Select Yes to format the CompactFlash memory card.
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Camera Controls

The PLAY/OFF/REC Auto Return Switch

Switching on the camera
• Slide the PLAY/OFF/REC auto return switch towards REC or PLAY.

# REC: The camera is switched on. Wait until the Green Action Indicator stops blinking
before recording an image.

# PLAY: The camera is switched on in playback mode. The color LCD displays the last
recorded image.

Automatic power off function
The camera is equipped with an automatic power off function. When the camera is not connected
to a computer, it shuts down automatically after 5 minutes of inactivity.

" Note: The LCD screen switches off automatically after 30 seconds of inactivity.

" Note: For more information about changing the interval of the automatic Power off
function, refer to the Auto Shut Down section in this manual.

To re-activate the camera:

• Slide the PLAY/OFF/REC auto return switch towards REC or PLAY.

Switching off the camera
• Slide the PLAY/OFF/REC auto return switch towards the active mode to shut down the

camera.

You hear a beep, the Green Action Indicator and display are dimmed.
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The Status Display

The display shows the camera settings you selected by means of icons.

Example of display information:

The display gives you information on:

! the number of images that still can be recorded

! the status of the batteries (full, half-full, nearly empty)

! the USB connection to a PC

! the resolution (Fine, High or Low)

! the selftimer setting (activated or not)

! the flash setting (activated or not and automatic)

The LCD Display

Use the 1.8” color LCD displays to frame or to preview images and to select options from the
Record or Play menu (a row of icons).

" Note: When no action is taken, the LCD switches off automatically after 30 seconds.
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The Resolution Button

Setting the resolution

Depending on the Image resolution you can record 4 images in Fine resolution (1280 x 960), 10
images in High resolution (1024 x 768) and up to 36 still images in
Low resolution (512 x 384).

! Note: According to the combination of Fine, High and Low resolution images you store in the
camera’s memory (or on the CompactFlash card), the capacity varies.

To change the resolution setting:

• Press the Resolution button.

a: Resolution button
b: Selftimer button
c: Flash button

On the display you see the icons of the option you set:

Icon Option

Fine (1280 x 960)
Fine image resolution — low compression
capacity: 4 images in the internal memory

High Resolution (1024 x 768)
High image resolution — standard compression
capacity: 10 images in the internal memory

Low Resolution (512 x 384)

Low image resolution — standard compression
capacity: 36 images in the internal memory

! Note: The image resolution setting is stored when you switch off the camera.
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The Selftimer Button

Activating the selftimer

• Press the Selftimer button to change the selftimer setting.

a: Resolution button
b: Selftimer button
c: Flash button

Activating the selftimer option, delays the recording of an image with 10 seconds after pressing the
shutter button.

! Note: In burst and video mode, the selftimer option is not available.
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The Flash Button

Activating automatic flash

• Press the Flash button to change the flash setting.

a: Resolution button
b: Selftimer button
c: Flash button

When you activated the automatic flash, the flashlight will go off if the scene you want to record
is too dark. In this case the flash will charge before you can press the Shutter button. The flash
ranges from 1 m to 2.5 m.

On the display you see the icons of the option you set:

Icon Option

Automatic flash

The camera determines when to use the flash.

Flash always on

Flash always off

! Note: The flash settings are not stored when you switch off the camera. When switching the
camera on, the flash is always off.

! Note: The flash option automatically switches off when recording images in burst mode or
video mode, or when the camera is USB powered.
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Jog Dial Wheel

Use the Jog Dial wheel to navigate through the menus and select a menu option:

1 Press the Jog Dial wheel to switch on the LCD screen in Record mode.

2 Press the Jog Dial wheel again to display a menu.

    

3 Use the arrows of the Jog Dial wheel to scroll from one menu option to another.

    
4 Press the Enter button in the center of the Jog Dial wheel to select the highlighted icon.

Shutter Button

• Press the Shutter button to record an image or videoclip.

Focus Switch

The focus switch allows you to choose a focal distance for your shots. For best results, the setting
should match the distance form the object to the lens.

" Macro: if the subject is 25 cm (9.8 “) away from the lens.

" Normal: for subjects between 65 cm (25.6”) and infinity away from the lens.

Print Button

After installing the CL34 software from the ePhoto CL34 CD, you can easily upload your images
from your camera to the internet for printing.

! Note: To use the Print button you have to install the AGFAnet client software.

1 Connect the ePhoto CL34 with the USB cable to your computer.

The Agfa Camera window appears.

2 Press the Print button on your camera.

Images indicated with the print-icon on your CL34 will automatically be selected (DPOF in
PLAY Mode).

3 The AGFAnet Print application starts.

4 Click Configure Connection to set up your connection.

5 Click Next to go through each step of the wizard.

! Note: For more information about the wizard, click the Help button.

After completing the wizard, the uploaded images will be printed and sent to your home.

! Note: For more information, refer to the AGFAnet CD-sized leaflet in your package or visit
http://www.AGFAnet.com

http://www.agfanet.com/
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Chapter 2: Recording Images and Videoclips
in Record Mode

Like a conventional camera, the ePhoto CL34 has an optical viewfinder. You can also frame the
image on the color LCD. Before you record images or video clips, make sure to install the batteries.

" Note: To extend battery life use the optical viewfinder instead of the color LCD for recording
images.

To record images:

1 Slide the PLAY/OFF/REC auto return switch to REC.

2 In case you want to frame an image using the color LCD (instead of using the optical
viewfinder), press the Jog Dial wheel once.

" Note: To save batteries use the optical viewfinder instead of the LCD.

3 If desired, change the camera settings (for more information, refer to “Changing Basic
Settings” further in this chapter).

4 Frame the image using the optical viewfinder or the color LCD.

5 Press the Shutter button to record the image.

The camera processes the image. The Green Action Indicator on the back of the camera
blinks. If the color LCD is on, the recorded image appears on the LCD. After a few seconds,
the live image reappears on the LCD and the camera is ready to record a new image.

" Note: If the QuickReview option is on, the color LCD displays menu options while the image is
built-up on the LCD (for more information refer to “QuickReview” further in this chapter).

To record images in Burst mode:

1 Slide the PLAY/OFF/REC auto return switch towards REC.

2 Press the Jog Dial wheel.

The LCD screen is switched on.

3 Press the Jog Dial wheel again.

The Record menu appears on the LCD with the Resolution icon highlighted.

4 Scroll by pressing the down arrow of the Jog Dial wheel to select the  icon.

5 Press the Enter button.

The Burst Mode is activated.

6 Press and hold the shutter button continuously to record 3 images/second for 3.5 seconds.

7 Release the shutter button to stop recording.
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" Note: The camera automatically stops recording after 3.5 seconds or when 10 images are
recorded. The total processing time of 10 images takes about 10 seconds.

" Note: Flash options are not available when recording in Burst mode.

To record video clips:

1 Slide the PLAY/OFF/REC auto return switch towards REC.

2 Press the Jog Dial wheel.

The LCD screen is switched on.

3 Press the Jog Dial wheel again.

The Record menu appears on the LCD with the Resolution icon highlighted.

4 Scroll by pressing the down arrow of the Jog Dial wheel to select the  icon.

5 Press the Enter button.

The Video Mode is activated.

6 Press the shutter button to start recording the videoclip.

7 Press the shutter button again to end the recording.

" Note: Without a CompactFlash memory card you can record videoclips up to 20 seconds
at 10 frames per second. After 20 seconds the camera automatically stops recording.
When a CompactFlash memory card is inserted, you can record videoclips up to 30
seconds at 20 frames per second before the camera automatically stops recording.

8 Choose Save to save the recorded videoclip.
-or-
Choose Delete to discard the recorded videoclip.

" Note: You can only record videoclips when the LCD is on.

Changing Basic Settings
You can change the basic camera settings with the icon menu that is displayed on the color LCD.
The basic settings are:

! Resolution/Recording Mode

! Digital zoom

! Flash

! Advanced

! Preview - LCD

" Note: The resolution remains in effect until you change it. Even when you switch the camera
off the setting will not change.

Select the advanced settings icon  to access the advanced settings menu. For more
information refer to “Changing Advanced Settings” further in this chapter.
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Changing a Basic Setting

1 Slide the PLAY/OFF/REC auto return switch towards REC.

2 Press the Jog Dial wheel.

The LCD is switched on.

3 Press the Jog Dial wheel again.

The Record menu appears on the color LCD.

! Note: After 5 seconds without pressing any button, the menu switches off.

4 Scroll by pressing the left/right arrow on the Jog Dial wheel to select the desired icon.

5 Press the Enter button or the up/down arrow of the Jog Dial wheel to select the icon.

A column of icons or a text menu appears.

6 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired icon or option.

7 Press the Enter button to select the setting.

Resolution/Recording Mode

The ePhoto CL34 provides the following resolution settings and recording modes:

Setting Description

Fine: 1280 x 960 pixels.

Fine image resolution (megapixel) and low compression.

Internal 2MB memory capacity: 4 images

High: 1024 x 768 pixels.

High image resolution and standard compression.

Internal 2MB memory capacity: 10 images

Low: 512 x 384 pixels.

Low image resolution and standard compression.
Ideal for posting images on the Web.

Internal 2MB memory capacity: 36 images

Video: 320 x 240 pixels.

Internal 2MB memory capacity: videoclip up to 20 seconds (AVI file) at 10 fps.
Maximum capacity with optional CompactFlash card: videoclip of 30 seconds (4.5 MB)
at 20 fps.

Burst: 512 x 384 pixels.

Maximum capacity: 3 images/second for 3.5 seconds (10 images in total).

! Note: The flash option automatically switches off when recording images in burst
mode.
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Digital Zoom

The digital zoom feature of the ePhoto CL34 lets you zoom into the center of the image.

Setting Description

1x

Digital zoom is off. Keeps the actual size of the image (default).

2x

Digital zoom is applied. This option zooms into the center of the image and
automatically sets the resolution to Low.

Flash

The ePhoto CL34 provides the following flash settings:

Setting Description

Automatic flash

The camera determines when to use the flash.

Flash always on

Flash always off

! Note: While the flash is charging, you cannot record images.

! Note: Flash cannot be used when recording images in Burst mode.
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Preview

The ePhoto CL34 provides four preview settings:

Setting Description

Normal

Shows the lighting conditions as seen through the lens (default).

Bright preview

For viewing dark scenes more brightly on the LCD screen (the actual exposure
does not change).

Dark preview

For darkening the LCD screen when framing light scenes (the actual exposure does
not change).

Off

To switch off the LCD.
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Changing Advanced Settings
Change advanced settings by using the advanced settings menu displayed on the color LCD. The
advanced settings are:

! QuickReview

! Exposure

! White Balance

! Sound

! Auto Shut Down

! Language

! Automatic

" Note: For information on how to change the basic settings, refer to “Changing Basic Settings”
earlier in this chapter.

Changing an Advanced Setting

1 Slide the PLAY/OFF/REC auto return switch towards REC.

2 Press the Jog Dial wheel.

The LCD is switched on.

3 Press the Jog Dial wheel again.

The Record menu appears on the color LCD.

" Note: After 5 seconds without pressing any button, the menu switches off.

4 Scroll by pressing the left/right arrow of the Jog Dial wheel to select the  icon.

5 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Advanced Settings menu appears.

6 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired option.

7 Press the Enter button to set the setting.

QuickReview

During the seconds that the image is processing, QuickReview offers you the choice to keep or to
delete the recording image. After processing the image, QuickReview saves the image
automatically.

Using QuickReview you can:

! Continue to return to preview mode and save the recorded image.

" Note: The Quick Review menu automatically switches off.

! Share the image on the LCD and save or delete it afterwards.

! Delete the image while it is still built-up on the LCD.
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To select QuickReview:

1 Select QuickReview in the Advanced menu.

The Quick Review menu appears.

2 Select On.

3 Frame the image and press the Shutter button.

The image appears on the LCD with the question to Delete or to Share the image.

4 Scroll by pressing the up/down arrow of the Jog Dial wheel and press the Enter button to
confirm your selection.

# Select Continue to return to preview mode and save the recorded image.

# Select Delete to delete the image immediately.

# Select Share to keep the image on the LCD.
Two new options become available:

Delete: to delete the image.

Continue: to save the image.

Exposure

The Exposure setting adjusts the aperture and the shutter speed. Use this option to manually adjust
the exposure.

For example: the darker the scene, the more light you need, the higher the exposure setting you
have to set.

" Note: The manual settings range from +3 to -3 using 0.5 f-stop values.
Each f-stop value increases/decreases the light intensity with 50%.

To set the exposure manually:

1 Select Exposure in the Advanced menu.

The Exposure screen appears with a vertical scale. The settings on the scale are automatic or
manual.

2 Scroll by pressing the up/down arrow of the Jog Dial wheel to increase (+) the exposure or to
decrease it (–).

3 Click the Enter button to set the exposure you want to use.
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White Balance

The White Balance is used to calibrate the colors of your images. This option lets you manually
adjust the color balance of an image so that the colors appear natural.

To set the White Balance manually:

1 Select White Balance in the Advanced menu.

The White Balance screen appears displaying 5 options:

# Automatic: the camera automatically sets the white balance.

# Daylight: when the subject is illuminated by (sunny) daylight.

# Cloudy: when the subject is placed in a cloudy environment.

# Fluorescent: when the subject is illuminated by fluorescent light.

# Tungsten: when the subject is illuminated by incandescent light.

2 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired setting.

3 Press the Enter button to set the white balance option you want to use.

Sound

Your camera can give a signal indicating the status of the camera and the completing of an action.

To set the sound manually:

1 Select Sound in the Advanced menu.

The Sound screen appears displaying 2 options:

# On: the camera gives a signal

# Off: the camera does not give a signal

2 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired setting.

3 Press the Enter button to set the option you want to use.
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Auto Shut Down
You can manually increase or decrease the time after which your camera (when no button is
pressed) automatically shuts down.

To set Auto Shut Down time manually:

1 Select Auto Shut Down in the Advanced menu.

The Auto Shut Down screen appears displaying 5 options:

# 1 minute

# 2 minutes

# 5 minutes (default)

# 10 minutes

# Never

2 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired setting.

3 Press the Enter button to set the option you want to use.

" Note: By default your ePhoto CL34 shuts down after 5 minutes.

Language
This option allows you to select the language for your ePhoto CL34 camera.

By default the menu system language for the ePhoto CL34 is set to English. To select French,
Spanish, German, Italian or Dutch as menu language:

To set the language manually:

1 Select Language in the Advanced menu.

The language screen appears displaying 6 options:

# Nederlands

# English

# Français

# Deutsch

# Italiano

# Español

2 Scroll by pressing the up/down arrow of the Jog Dial wheel to select the desired language.

3 Press the Enter button to set the desired language.

Automatic
This option resets the exposure and white balance settings to their default values.

To activate the automatic option:

1 Select Automatic in the Advanced menu.

2 Press the Enter button to reset the exposure and white balance settings to their default values.



Chapter 3: Working with Images in Play Mode 31

Chapter 3: Working with Images in Play Mode

You can use the ePhoto CL34 PLAY mode to view and work with recorded images/videoclips in
single-image view and multi-image view.

Setting Description

Single-Image View

Use single-image view to preview one image or videoclip at the time.

Multi-Image View

Use multi-image view to preview up to 9 thumbnails at a time.

To view a recorded image:

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last image recorded, in single-image view.

2 Scroll by pressing the left/right arrow of the Jog Dial wheel to see the previous/next image in
single image mode.
-or-
Press the Enter button or the up/down arrow of the Jog Dial wheel to activate the PLAY menu.

The Play menu appears on the LCD with the  icon highlighted.

3 Press the up/down arrow to select the  icon.

! Press the Enter button.
Up to 9 thumbnail images appear on the LCD.

! Scroll by pressing the left/right arrow of the Jog Dial wheel through the recorded images.

! To return to single-image view, click the Enter button again and select the  icon.

" Note: If no images are stored, you see the message “No Picture”.

To view a recorded videoclip:

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Scroll by pressing the left/right arrow of the Jog Dial wheel to the desired videoclip (AVI file).

" Note: A videoclip is marked with the video icon.

3 Press the Enter button to start the videoclip.

" Note: The Enter button functions also as the pause button.

" Note: The Play menu will re-appear when pressing the Up/Down button of the Jog Dial wheel.
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Using Single-Image View

Scrolling through the Images in Single-Image View

To scroll through recorded images:

" Note: Recorded videoclips are marked with a video-icon. When referring to images in Single-
Image view this includes videoclips, unless specified otherwise.

1 Slide the PLAY/OFF/REC auto return switch to PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Scroll to the previous or the next image using the left/right arrow of the Jog Dial wheel.

The next/previous image is shown in single-image mode.

" Note: You can display the image counters if you are using single-image view. For more
information refer to “Displaying Information in Single-Image View” further in this chapter.

" Note: You revert to the first image if you scroll further after viewing the last image.

Deleting Images in Single-Image View

To delete images:

1 Slide the PLAY/OFF/REC auto return switch to PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Scroll to the image you want to delete using the left/right arrow of the Jog Dial wheel.

3 Press the Enter button.

The PLAY menu appears on the LCD.

4 Scroll using the left/right arrow of the Jog Dial wheel to highlight the Delete option.

5 Press the Enter button.

The Delete images screen appears.

6 Select one of the following options:

! Reformat: To delete all images that are stored on the memory card and reformat the card.

! Current: To delete the selected image.

! All: To delete all images.

" Note: If you select Current or All, a confirmation screen appears. Select Yes to delete the
image(s) and exit the menu. Select No to exit the menu without deleting any images.

" Note: If you select Reformat, a confirmation screen appears. Select Yes to reformat the
memory card. Select No to exit the menu without reformatting the memory card.

! Exit: to leave the menu without deleting any images.
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Zooming in on an Image in Single-Image View

The camera’s digital 2x zoom allows you to select a part of an image and to zoom in on it.

To zoom in on an image:

1 Slide the PLAY/OFF/REC auto return switch to PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Scroll to the image you want to zoom in on using the left/right arrow of the Jog Dial wheel.

3 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The PLAY menu appears on the LCD.

4 Scroll using the arrows of the Jog Dial wheel to highlight the  option.

5 Press the Enter button.

The image re-appears with a crop-frame placed in the center.

" Note: Scroll with the arrows of the Jog Dial wheel in either direction to select the area you
want to zoom in on.

6 Press the Enter button.

Printing Images in Single-Image View

The Printing option can only be used in combination with a minilab that supports DPOF (Digital
Printing Order Format) or with a printer that supports DPOF.

" Note: Videoclips cannot be printed.

To tag images for printing:

1 Slide the PLAY/OFF/REC auto return switch to PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Scroll to the image you want to tag using the left/right arrow of the Jog Dial wheel.

3 Press the Enter button.

The Play menu appears on the LCD.

4 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  option.

5 Press the Enter button.

The DPOF Print menu appears.

6 Select the desired option:

! Print Image: to tag images for printing:

! Cancel Print

! Print All: to tag all images to print.

! Cancel All: do not print All

! Exit: to leave the menu without saving any print.

" Note: Images indicated with the print-icon on your CL34 will automatically be selected when
pressing the print button(DPOF in PLAY Mode).
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Displaying Information in Single-Image View

You can display the image counters and the resolution setting in single-image view.

To display information for each image:

1 Slide the PLAY/OFF/REC auto return switch to PLAY.

The color LCD shows the last recorded image, in single-image view.

2 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

3 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  option.

4 Press the Enter button or the up/down arrow of the Jog Dial wheel.

Following information will be displayed when viewing images in single image mode:

! Resolution setting

! Current Image/Total images

To switch off the display information for each image:

1 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

2 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  option.

3 Press the Enter button.

No information will be displayed when viewing images in single image mode.
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Using Multi-Image View

Viewing Images in Multi-Image View

To view multiple images at a time:

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last image recorded, in single-image view.

2 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

3 Scroll using the up/down arrow of the Jog Dial wheel to highlight the  icon.

4 Press the Enter button.

The LCD displays up to 9 numbered thumbnail images, with the last image selected (outlined
by a white frame).

" Note: You cannot display the image counters and date and time in multi-image mode.

5 Scroll by pressing the left/right arrow of the Jog Dial wheel through the thumbnails.

" Note: When you reach the last thumbnail on the screen, you can scroll further to add a new
row of thumbnails to the screen (if there are more than 9 images). After the last thumbnail you
return to the first thumbnail.

Deleting Images in Multi-Image View

In multi-image mode you can delete one image at a time or delete all the images at once:

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last image recorded, in single-image view.

2 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

3 Scroll using the up/down arrow of the Jog Dial wheel to highlight the  icon.

4 Press the Enter button.

The LCD displays up to 9 numbered thumbnail images, with the last image selected (outlined
by a white frame).

" Note: You cannot display the image counters and date and time in multi-image mode.

5 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  option.

6 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Delete images screen appears.



Chapter 3: Working with Images in Play Mode 36

7 Select one of the following options:

! Reformat: To delete all images that are stored on the memory card and reformat the card.

! Current: To delete the selected thumbnail one by one.

! All: To delete all images.

! Exit: The PLAY menu re-appears without deleting an image.

" Note: If you select Reformat, a confirmation screen appears. Select Yes to reformat the
memory disk. Select No to exit the menu without reformatting the memory disk.

Printing Images in Multi-Image View

The Printing option can only be used in combination with a minilab that supports DPOF (Digital
Printing Order Format) or with a printer that supports DPOF.

To tag images for printing:

1 Slide the PLAY/OFF/REC auto return switch towards PLAY.

The color LCD shows the last image recorded, in single-image view.

2 Press the Enter button or the up/down arrow of the Jog Dial wheel.

The Play menu appears on the LCD.

3 Scroll using the up/down arrow of the Jog Dial wheel to highlight the  icon.

4 Press the Enter button.

The LCD displays up to 9 numbered thumbnail images, with the last image selected (outlined
by a white frame).

" Note: You cannot display the image counters and date and time in multi-image mode.

5 Scroll using the left/right arrow of the Jog Dial wheel to highlight the  option.

6 Press the Enter button.

The DPOF Print screen appears.

7 Select the desired option:

! Print Image: To select the current thumbnail (one by one) for printing.

! Cancel Print: To remove the print tag from the selected image.

! Print All: To tag all images to print.

! Cancel All: To remove all print tags from the images.

! Exit: To leave the menu without saving any print.
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Chapter 4: Transferring Images to Your PC

Installing the Required Software
" Note: Make sure to install the required software before connecting your ePhoto CL34 camera

to your PC.

1 Insert the ePhoto CL34 CD in the CD-ROM drive.

" Note: If the Installation does not start automatically, double-click My computer, double-
click the CD-ROM icon and double-click Setup.exe.

2 Select your language and follow the instructions.

# AGFAnet client software
To send images over the internet for printing on photopaper.

" Note: The Print button on your ePhoto CL34 camera will only be available when the
AGFAnet client software is installed.

" Note: To use the Agfa Internet Print Service, you need the AGFAnet client software. For
more information, refer to the AGFAnet CD-sized leaflet in your package or visit
http://www.AGFAnet.com

# Agfa PhotoWise
To organize your images in albums and make slideshows.

# VideoImpression
To capture video clips (over the USB cable).

# NetMeeting
To video-conference (over the USB cable).

" Note: The installer in the NetMeeting folder will also install or update Internet Explorer if
necessary.

Caution: After installing NetMeeting you have to restart your computer.

# Adobe Acrobat
To read the User’s Guide.

# Driver Software
The Driver software will install the Video Driver, the AgfaCam Mounter and the Twain
Driver in order to transfer or save still images.

Caution: After installing the Driver Software you have to restart your computer.

" Note: When installing the software manually, make sure to install the Driver Software after
installing the other applications. The Driver Software will then automatically detect the
previous installed software.

3 Follow the instructions in the successive screens.

http://www.agfanet.com/
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Connecting the Camera to Your PC
1 Open the USB compartment door.

2 Plug one end of the USB cable into your camera’s USB port.

3 Plug the other end of the USB cable into your computer’s USB port.

The USB port on your PC is labeled with the USB icon  as shown in the picture below.

4 Slide the PLAY/OFF/REC auto return switch towards REC.

The AgfaCam Mounter appears.
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Viewing and Saving Images on Your PC Using the
AgfaCam Mounter
With the AgfaCam Mounter you can retrieve and view images from your camera. As an alternative
method to copy images to your computer and manage them in an efficient way, use PhotoWise. For
more information, refer to Chapter 5: Organizing Images Using PhotoWise.

Using the AgfaCam Mounter:

1 Connect your ePhoto CL34 to your PC as described in Connecting the Camera to Your PC.

The Agfa Camera window appears.

" Note: After closing the Agfa Camera window you can re-open it by double-clicking My
Computer, Agfa Camera.

2 From the View menu, select Explorer Bar, Folders.

The Explorer bar appears.

3 Select the thumbnails you want to transfer to your PC.

4 Drag them to the desired folder or application in the Explorer Bar.
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Chapter 5: Organizing Images Using
PhotoWise

With PhotoWise you can download images from your camera and organize them in rolls of film.

1 Connect the camera to your computer as described in Connecting the Camera to Your PC.

The AgfaCam Mounter appears.

2 Open PhotoWise by clicking the PhotoWise 3.x.icon.

The PhotoWise window appears.

3 Right-click the Camera icon and select ‘Digital Camera Input Setting’.

The ‘Digital Camera Input Setting’ window appears.
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4 Select ‘AgfaCam Mounter’ as source (if needed).

5 Select ‘Create a new roll of film’ to download the images to the new roll of film.

PhotoWise proposes the actual date as default name for the new roll of film and for the
destination folder.

! Note: You can change the proposed destination (Path) and the name of the film by

entering a different path manually or by using the  button. You can also change the
name of the film by entering a new name in the Film field. The images will then be
displayed in the new created roll of film (in PhotoWise) and will be saved in the destination
folder described in the Path field.

-or-

Clear the check box ‘Create a new roll of film’ to download the images to the default
destination folder and roll of film or to the destination folder and roll of film that you created
previously.

6 Select ‘Always ask for each input’ if you want the ‘Digital Camera Input Setting’ window to
appear every time you download images from your camera to your computer.

-or-

Clear the check box ‘Always ask for each input’ to save the downloaded images automatically
to the destination (folder) and the roll of film that you selected before. If this folder already
contains images, the new images will be added to the folder without deleting or overwriting the
older images.

7 Click OK.

8 Click the Camera icon.

! Note: Make sure the camera is connected to your computer via the USB cable as
described in Connecting the Camera to Your PC.

The ‘Download’ window appears.
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9 Click ‘Select All’ or select manually the images you which to transfer to your hard disk.

! Note: To select multiple images hold down the Ctrl key while selecting the desired
images.

10 Click the ‘Download’ button.

If you have selected ‘Always ask for each input’ in the ‘Digital Camera Input Setting’ window,
this window will reappear. You can specify a new destination (Path) and a new roll of film
before clicking the OK button.

-or-

If you haven’t selected ‘Always ask for each input’ in the ‘Digital Camera Input Setting’ window,
the images will be saved in the default destination folder (Path). The images will be displayed
in the PhotoWise thumbnail view under the roll of film that was open before you downloaded
the images.
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! Note: To consult and add additional information about an image, click the  icon underneath
the image.

! Note: For more information, refer to the PhotoWise online help system. You can access the
online help system by pressing ‘F1’ or by moving your cursor to the top of the window and
choose ‘Help Topics’ from the ‘Help menu’.
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Chapter 6: Ordering Prints Over the Internet
Using AGFAnet Print Service

After installing the CL34 software from the ePhoto CL34 CD, you can easily upload your images
from your camera to the internet for printing. There are two ways to upload your images to the
internet.

! Using the Print Button

! Using the AgfaCam Mounter

Ordering Prints Using the Print Button
1 Install the software as described in Installing the Required Software.

" Note: To use the Print button you have to install the AGFAnet client software.

2 Connect the ePhoto CL34 with the USB cable to your computer as described in Connecting the
Camera to Your PC.

The AgfaCam Mounter appears.

3 Press the Print button on your camera.

4 The AGFAnet Print application starts.
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5 Click Configure Connection to set up your connection.

6 Click Next to go through each step of the wizard.

" Note: For more information about the wizard, click the Help button.

After completing the wizard, the uploaded images will be printed and sent to your home.

Ordering Prints Using the AgfaCam Mounter
1 Install the software as described in Installing the Required Software.

2 Connect the ePhoto CL34 with the USB cable to your computer as described in Connecting the
Camera to Your PC.

3 Repeat the procedure described in Viewing and Saving Images on Your PC Using the
AgfaCam Mounter.

4 Select the thumbnails you want to transfer to AGFAnet Prints.

5 Drag the desired images onto the AGFAnet Print application icon.

The AGFAnet Print application starts.
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6 Click Configure Connection to set up your connection.

7 Click Next to go through each step of the wizard.

" Note: For more information about the wizard, click the Help button.

After completing the wizard, the uploaded images will be printed and sent to your home.
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Chapter 7: Using the ePhoto CL34 for Video
Applications

Videoconferencing with MS NetMeeting

Videoconferencing over the Internet

To use NetMeeting® 3.0 (or higher) over the internet you need a modem for internet connection
and Internet Explorer® 4.01 (or higher).

Visit http://www.netmeet.net/bestservers.asp and choose an Internet Locator Service (ILS) server
for your country and write down the address (you will need this to specify the ILS Server).

1 Connect the ePhoto CL34 to your computer with the USB cable.

2 Switch on the camera.

3 Connect to the internet.

4 Choose Start > Programs > Accessories > Communications > NetMeeting to launch MS
NetMeeting or click the NetMeeting link in the AgfaCam Mounter.

5 Choose Option from the Tools menu.

6 Specify the Videoconference ILS Server address in the Directory Settings box.

7 Select the Directory option in the Call menu.

8 Choose someone to videoconference with.

9 Activate the video receive function by clicking the Play button.

10 Choose the Video Send and Receive from the Tools menu.

Videoconferencing over LAN

Using NetMeeting over a Local Area Network (LAN), you only need to make a new call (Call / New
Call) and fill in the TCP/IP address or computer name of the person you want to videoconference
with.

http://www.netmeet.net/bestservers.asp
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Capturing Video Images with VideoImpression
1 Connect the ePhoto CL34 to your computer with the USB cable.

2 Switch on the camera.

3 Choose Start > Programs > ArcSoft Video > ArcSoft VideoImpression to launch
VideoImpression.

4 Click the New button to capture video.

5 Select the Capture Video button (camera icon).

6 Select “ePhoto CL34” in the Driver list (if needed).

7 Click the Format button.

The Format window appears.

8 Set the desired output size (resolution).

9 Click OK.

The VideoImpression window reappears.

10 Click the Record button to start recording.

11 Press the ESC-key on your keyboard to stop.

12 Click the Save button (floppy icon) to save your video on your computer.

" Note: Depending on your hardware configuration, you may have to select a lower resolution in
order to obtain a smoother video clip. To do so, click the Format button.
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Opening and managing videoclips with
VideoImpression
You can play, edit and save recorded videoclips on your computer using VideoImpression.

1 Connect your camera to the PC as described in Connecting the Camera to Your PC.

The Agfa Camera window appears.

2 Drag the desired videoclip onto the VideoImpression icon.

" Note: Videoclips are indicated with the video-icon.

The videoclip will be opened in VideoImpression.

3 Play, edit and save the videoclip.

" Note: For more information on working with VideoImpression, consult the Help system or visit
http://www.arcsoft.com

http://www.arcsoft.com/
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Appendix A: Troubleshooting and Support

Troubleshooting

The camera does not start up

! The camera is switched off. Slide the PLAY/OFF/REC auto return switch towards REC or
PLAY.

! The camera is automatically switched off because of 5 minutes of inactivity. Slide the
PLAY/OFF/REC auto return switch towards REC or PLAY.

! The batteries are too weak. Replace them.

The Shutter button does not work

! The camera is still recording an image.

! The flash is still charging. Check the Green Action Indicator.

! The internal memory or the optional CompactFlash card is full.

The built-in flash does not work

! The flash is off. Check the flash setting.

! The camera is set to Burst or Video mode.

! The camera is powered by USB (connected with the USB cable).

The recorded videoclip on your camera does not open on your computer.

! To open AVI-video files from your ePhoto CL34, you need to have the CL34 drivers installed
from the CL34 CD-ROM or you should download 2 AVI codec files for your ePhoto CL34 from
http://support.agfa.com.

http://support.agfa.com/
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Support

For more information and support on your Agfa ePhoto CL34:
Visit http://support.agfa.com and http://www.agfa.com
The most effective way to find an answer to your problem is to execute the successive steps
described below.

1. Create an Agfa e-Service Account

You need to create an Agfa e-Service account to benefit from:

! personalized online technical support;

! access to customized self-help tools and technical information;

! automatic e-mail notification of all new support documents;

! the latest Agfa product news.

To create an Agfa e-Service account and to register your CL34 camera:

• click Create your e-Service Account.

If you already have an Agfa e-Service account:

• Go to http://support.agfa.com and click Add/Register Product to add your “ePhoto CL34” to
your e-Service.

2. Consult the Solution Finder Database

• Click the Solution Finder tab to consult the standard answers on various problems/questions.

3. Consult the Support Documents Database

• Click the Support Documents tab to read the latest technical product news.

4. Consult the Software Library

• Select the Software Library tab to retrieve available software updates for your ePhoto CL34
camera.

5. Contact the Nearest Service Office

• Select the Service Offices tab to find the hotline number of your nearest Agfa Service Office.

6. Personalized Online Support

If you do not find an answer to your problem/question in the Solution Finder or in the Support
Documents Database:

1 Click Agfa Online Support Home to open Personalized Online Support.

2 Describe your problem as accurate as possible.

http://support.agfa.com/
http://www.agfa.com/
http://support.agfa.com/
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For more information and support on MS NetMeeting:
Consult the help system or visit http://www.microsoft.com/windows/netmeeting and
http://www.netmeet.net

For more information and support on VideoImpression:
Consult the help system or visit http://www.arcsoft.com

For more information and support on PhotoWise:
Consult the online help system.

http://www.microsoft.com/windows/netmeeting
http://www.netmeet.net/
http://www.arcsoft.com/
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Appendix B: Camera Specifications
Parameter Specifications

Image Resolutions 1280 x 960 pixel resolution (Fine); 1024 x 768 pixel resolution
(High); 512 x 384 pixel resolution (Low)

LCD Display Black and white status display
1.8” color LCD

Color 24-bit (millions of colors)

Memory 2 Mb internal memory

CompactFlash slot Type 1

Lens Focal range = 65 cm (25.6“) – infinity

25 cm (9.8”) in Macro mode

f = 7.1 mm (50 mm equivalent)

White Balance Automatic or manual

Built-in Flash Automatic, Off, On
Flash range: 1 m – 2.5 m

Selftimer On, Off

Shutter Speed 1/10 sec to 1/2000 sec (auto)

Weight <200 g (7 oz) without batteries

Dimensions 75(H) x 119 (W) x 51 mm / 2.95”(H) x 4.68”(W) x 2”
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